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Priority Software® BA3: User’s Manual 
 

Getting started in Priority: 
• Locate the Priority icon on your desktop and double-click to open: 
 
• When the log-in screen pops up, enter your log-in name and password, then click 

“OK” (Change your password on your initial visit to this screen.) 
 

 

 
 
 If the log-in screen does not open, check and verify that your VPN Client is 
activated.  Locate the VPN icon on your computer and double click.  Highlight the 
UMAPPS choice for access, unless you are working wireless then press the “Connect” icon; 
enter your user name and password, which are the same as your ARES name and 
password. 

• A “Tip of the Day” window will pop up. Click on “Previous Tip” or “Next Tip” 
to see more tips, or just click “OK” to continue 
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You have now opened Priority!  
This screen will appear with top news and information: 
 

 
 
 
At the lower part of the screen, you will at times see a red, yellow, or green symbol:  
 

• Red means you cannot enter any new data until a new patch has been uploaded 
into Priority. Unless you can add software to your computer, this requires 
notifying IT that they must put in the new software update before any new 
additions can be made. 

 
• Yellow means that there have been some software changes. They should be 

included in the system, and they won’t affect any new data that will be entered. 
 

• Green means you are operating in the most current version of the software. 
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There are 7 major areas in Priority: 
Accounting 
Donations 
NCI 
Personnel 
Publications 
Maintenance 
User 
 
They are listed on the left menu: 

 
Note: You will be dealing only with (1) Accounting and (4) Personnel.  The other 
areas are not in use at the University of Maryland. 
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To get started, you will want to check account and person records. The following 
pages will provide instructions on how to do these things. 
 

• Under both Accounting and Personnel, you will find the options “Forms” and 
“Reports.” Click on either one to display these options: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Forms are used to enter new data into the system. You will go here to review 

and update accounts and persons, input encumbrances, edit saved information, 
and do other things requiring data entry.  

 
Click on “Forms” to display the different forms you can use 

 
• Reports are used when you want to view data that have 

already been entered into the system. When you are in Reports, you cannot 
enter new information into the system. (New information 
must

 
 be entered through “Forms”.) 

Click on “Reports” to display the different reports you can view 
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ACCOUNTING 
 
Reviewing accounts: 
 

 
 

• Click on “Forms” from the left 
menu under Accounting: 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Locate the  Accounting Forms 

menu and click on the first item: 
“Account Information” 
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• A window will pop up. The data you will find on this form is set up from an FRS 
download, so it is taken directly from FRS. The account information is similar to 
the information contained in the FRS account header.  

 
•  Before entering any information into this form, you will need to filter (search) the 

system for existing data pertaining to the account you want to add. To search for 
existing data, click on the “Filters” tab: 

 
 

 
 
 
 
• “Filters” is Priority’s search engine. Anytime you need to search for data in 

Priority, go to the “Filters” tab on the form you are using. 
 
 
 
 
 
 Always start by checking through filters to make sure that the information you are 
about to enter is not already in the system.  
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• To check an account through filters

 

: Enter the six-digit FRS account number 
(without dashes) and click “Apply” in bottom right-hand corner. If this account is 
already on record, the information will appear on the General Tab. If there are no 
records for this account, it will say “No records found matching filter criteria” at 
bottom of window. Please wait until FRS download creates the account in 
Priority.  FRS will download 24-48 hours after the ATS is released, except at the 
Fiscal year end.  The new Fiscal year account information downloads don’t start 
until after the 06/32/FY close is completed.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Review the account information; if the data is from an old account, please email 
Sharon Elliott at selliott at umresearch.umd.edu with the account number and she 
will research the problem and get back to you. 

 

Account FRS # 

mailto:selliott@umresearch.umd.edu�
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Review the following information on the General Tab: 
 NOTE: Required fields are indicated by * (asterisks). They are as follows: 

1. Account number (the six-digit FRS number)—enter without dash 
Example: 5-54321 would be entered as 554321. Double-check the “Area” 
field to make sure it is correct. Priority has it automatically entered into 
the system, and the user can not change it. If it is incorrect, you must 
contact Sharon Elliott at: selliott at umresearch.umd.edu. 

2. Year: grant year or fiscal year (it can be either the year of funding or the 
fiscal year).  Example: UM fiscal year starts in July, eg: July’07 or FY08, 
on contracts and grants you can use the start date or on grants with 
multiple years of funding you can use Y1-3, meaning years 1 through 3. 

3.  Account Type : imports as a “grant”, but the user can change it (select 
from list by clicking on square to right of field—indicated below in red 
circle) Example:  contract, grant, etc.  Your choice will affect whether or 
not fringes will appear on the account. 

4.  Short Name (project sponsor number ) This will automatically download 
5.  Long Name (project title from FRS) 
6.  Budget Start & End dates (for the year, if state or account years, if 

grant)  
7. Automated F&A (choose the F&A rate) (see page12) add cross ref 
 

 
 
    mm-dd-yyyy 

1. FRS Number 

5. Project Title from FRS 

year Select from list 

4. Automatic 

6 

7 

2 3 

8 

9. 
10 

mailto:selliott%20at@umresearch.umd.edu�
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Priority will automatically assume some Account Budget dates when you input a 
transaction. The dates on the “Year Set as Current” are assumed. If you want to set a 
different year as current, click on “Set Year as Current” button at the bottom of the 
screen.  A check mark appears to the right of the word “Account Number”, when the 
account year has been set has current. 
 

 
 
 
All other fields are optional. They include: 
 

8.  Status (select from list: archive, active, closed, expired, or pending). The 
Account status must be set as active if the user wants to monitor it in BA3. 

 
9.   FRS Organizational unit (department or unit #)—each department has 

its own code. If you do not know what yours is, ask your Payroll person. 
Example: the code for VPR is 1420101 
 
 
 

 
 
 
 
 
10.   Default object Mapping - For reporting purposes, you can compress 
 multiple sub-codes into one report line item area, such as “Supplies” could 
contain the sub-codes 3716, 3914, 3916, 3952, 3953 and 3990.  You can look 
at other departments and use them but you cannot edit them.  If you need a 
mapping set up for your department email Sharon Elliott at selliott at 
umresearch.umd.edu  
 
SEE 8, 9 and 10 IMAGES ON THE PRECEDING PAGE 
 
 

 

mailto:selliott@umresearch.umd.edu�
mailto:selliott@umresearch.umd.edu�
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• If you want the name of this grant to appear on the financial statement report you 
need to copy/add it to the “Notes” tab.  This will print the title onto the financial 
statement report.  Anything in the “Notes” tab will print onto the financial 
statement report. An easy way to copy this information , highlight the information 
use CTRL C to put it on the clipboard, click on notes tab and enter into the Edit 
mode and use CTRL V. 

 
 

• To save your changes, click once on “Edit” at the bottom of your screen. It will 
then say “Saved” which means your information is now saved. CTRL E may also 
be used to enter Edit Mode.  CTRL S may also be used to save the record. 

 
 
 
 
    
 
 
 
 

Next, click on the “Persons” tab: 
 

 
 
 
 

• If desired, enter information for the following: 
 

1. Investigator (project director, a.k.a. Principal Investigator) 
2. Local Accountant (Normally this is the Business Office Person) 
3. Central Accountant (This could be the Director or 2nd

 
 Level Person) 

 
 
 
 

Note: You can select persons from list to right of field 
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• Enter information for the following: 
o Investigator (project director) 
o Local Accountant  
o Central Accountant 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 If there is a person who is not on the list, open the Persons form and click on “Persons”, 
filter for the name and add this responsibility on the “Indicators” tab. 

• To save your changes, click once on “Edit” at the bottom of the screen.  
 
 
How to edit saved information: 
 
If you need to make changes to information that you have already saved, please follow 
these steps: 

• Click on the appropriate tab. For example, if you need to change the name of the 
local accountant, you would click on the “Persons” tab 

• At the bottom right-hand corner of the window, find where it says “Saved” and 
click once: 

 
 

(User may also use CTRL E to enter Edit) 
• It will change to “Edit” and you are then able to make changes to the information 

 
 
 

 (User may also use CTRL S to save the record) 
 Remember to save the changes that you make by clicking where it says “Edit”. 

Project director   (select from list): 

Account #1          (select from list): 

Account #2          (select from list): 

1 

2 

3 
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Automated F&A Cost Feature 
Some Important Information about the automated F&A calculation 

 
• Automated Indirect Cost updates once per night 
• Automated F&A calculates on expenditures and open encumbrances, if a 

department wants to encumber the budgeted amount of F&A on the grant, do not 
select IRC schedule. 

• F&A encumbrance and payment distribution are stored in the Accounting 
Forms/Transactions/Encumbrances section of the system with reference number 
IDC + the account number, e.g. IDC525000 would be the reference number for 
F&A on FRS account number 5-25000 

•  Automated F&A calculation will ignore any Direct Expense form where the 
reference number starts with “YTD” 

• The user can update the F&A at any time by opening “Account Information, 
Filtering on the account number and going to “Tools” and clicking “Refresh 
IDC”. 

• When the user brings up “Reconciliation Wizard” the system will update F&A 
automatically 

• Normally F&A is applied to projects.  If a user does not want F&A on the project, 
check the box in Account Information Flags Tab to suppress project IDC. 
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Enabling the Automated IDC Feature 
• Open the Accounting Forms/Account Information Screen by clicking on the 

blue “Account Information” 
 

 
  
This opens the Account Information screen 
• Click on the “Filters” tab 
 

 
 
• Enter the account number and click on “Apply” 

 
 

• Click on the “General” tab 
 

 
 

• Enter “Edit” mode (click on the lock on the lower right side of the screen or 
hit “CTRL E”) 

   changes to  when the user clicks on the lock 

Account FRS # 
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• Select the F&A rate for this account by clicking on the   three dots next to 
the IRC Schedule field 

 

 
• Select the Indirect Rate (F&A) from the drop down box (All rates start with 

MTDC, TDC or other) – contact Sharon Elliott at selliott at 
umresearch.umd.edu  if you need an official campus rate added to the table. 

• Save the record by clicking on  or hitting “CTRL S” 
 
   changes to   when the user clicks on the pencil 
 
 
The system calculates and posts the account F&A during the overnight cycle.  Below is a 
screenshot of  IDC encumbrance form for VPR test account t-24654 showing the 
Automated F&A calculation? This is the general tab on the form. 
 

 
 

FRS Account Number - this is a test account so it starts with a “t” instead of the normal 
ledger number. 

 
Below is the distribution tab of the F&A Encumbrance form for the same test account.  
Note the system calculated expenditure amount. The amount was calculated on current 
month expenditures posted at the time of the overnight cycle. 
 
 
 

System 
calculated 
F&A  

IRC=F&A 

mailto:selliott@umresearch.umd.edu�
mailto:selliott@umresearch.umd.edu�
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  Total of F&A on this account 
  Total of F&A spent on this account 
  Balance of F&A on this account 

 

Setting up projects: 
 
Projects are a way of segregating and reporting on data that units may want to track for 
various purposes. Users set the project code(s) up on the account(s) and then enter that 
project code when they are entering transactions. Projects may be used to segregate data 
(pots of money) within one (1) account or to aggregate data (pots of money) across 
multiple accounts.  Users may have the same project code set up for different accounts. 
The system reports are capable of collecting the project data from all accounts in your 
area when you produce reports by project. 

• Click on “Forms” from the left menu under Accounting. 
 
• Locate the Accounting menu and click on the first item: “Account Information”. 

 
• Click on the “Filters” tab: 
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• Enter the 6-digit FRS number for the account you want to access. Then click on 
the “Apply” button: 

• The account information will appear. Next, click on the “Projects” tab: 

• Project code and description “**Null**” will appear on the first line of every 
account. (The system will use this project code for all transactions if a unit does 
not set up other project codes for an account.)  Each account must have Project 
“Null”. 

• Move to the second line and enter the project code(s) of your choice. Keep in 
mind that users see the project code when entering transactions.  

• Enter a name and check the “Active?” box in order to set up the project code. If 
you wish, you may enter an investigator. If the person does not appear on the drop 
down box see instructions on page 11 for checking the indicator flag on the 
Persons Tab. 

Account FRS # 
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• You also have the option of setting this project code as a default. Transactions 
entered on this account will assume the default project code if a user does not 
enter a different project code. 

 

 
 
 

• You may enter new codes by moving to the next line of the form. To do this, click 
“Tab” on your keyboard until your cursor jumps to the next line.  The system will 
automatically save the previous line when the user tabs to a new line before 
exiting the form. 

 
Granting BA3 permission to projects is explained on Page 25  
 
NOTE: Departmental users may choose to use automated IDC.  If Departmental users 
select automated IDC on the account, they may choose to allocate IDC to the project 
level. 
 
IDC on Projects 

• System calculates and allocates F&A on project expenditures and encumbrances, 
unless user elects to suppress project level IDC on the Account Information Form, 
“Flags” tab. 

• F&A is posted to the same project as the expenditure/encumbrance 
• To suppress F&A on projects on account information open “Flags” tab and click 

on the suppress project IDC. 
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How to Set BA Central Account and Project Permissions 
It is through permissions that you give access to see BA Central on-line. 

 
Some Important Information about BA Central 

 
• Users with BA3 access automatically have access to BA Central 
• Users without BA3 access must complete an SOU to access BA Central and 

receive their User ID 
• Departmental BA3 Data Admins control the account and project permissions 

that allow a BA Central User to view accounting reports and projects; account 
permissions automatically confer project permissions for that account 

• Project permissions must be set up also.  Some users can be given only project 
access, if they should not have access to the entire account. 

• If “My Project” balance on the BA Central Projects updates every night, if the 
user drills down into the project data, it updates as changes are made.  

• BA Central Accounts are updated when a BA3 User reconciles an account or 
posts financial reports/documents 
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Giving a BA Central User permission to the entire account (you must be a Data 
Admin to add permissions)   
 

• Open the Accounting Forms/Account Information Screen by clicking on the 
blue “Account Information” 

 
 

 
 
 
 

 
 
This opens the Account Information screen 
 
• Click on the “Filters” tab 
 

 
 
 
 
 
 
 
• Enter the account number and click on “Apply” 

 

 
 

Account FRS # 
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Click on the word “Tools”  
 

 
 
 

 
 
 
System displays the current account permissions.  
 

 

Users with Explicit Permissions for 
the Account may be added, 
modified, or removed by 
departmental Data Admins. Global 
departmental security group 
permissions (VRP Accountants, 
etc. in this sample, in the screen 
shot on the left) should not be 
changed by departmental users. 

Users with Inherited Permissions 
for the Account cannot be changed 
by departmental Data Admins. 

Click on the “General” tab 
and review the account 
information 

Click on the word “Tools”  
 

Click on the drop down 
menu “Permissions” 
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• Click on the  button on the right side of the screen to add a PI or 
other specific user to the Explicit Permissions list 

 
 
System displays a list of users in the drop down box  
 
 

 
 
 
 
System displays the new user in the list of user with the default “Explicit Permissions”  
 
 

 
 
 
 
System displays the default account settings for the new user 
 
 

 
 
 
 
 

User clicks on the User Name they want to add and 

hits the   button 
 

User highlights the line with the new user 
and clicks on the   button 
 

User changes the drop down box settings to 
“Read” to allow the new user to see the 
account information on BA Central. 
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The revised screen looks like this: 

 
 
 
 

Project Permissions: 
 
 

• Click on “Forms” from the left menu under Accounting 
 
• Locate the Accounting menu and click on the first item “Account Information” 

 
• Click on the “Filters” tab and enter the six-digit FRS account number for the 

account that you want to add permissions to. Then click “Apply” to display the 
information 

• Click on the “Projects” tab: 
 

 
 
 
 

• Highlight the project you want to grant permission then click on the 
“Permissions” button at bottom right-hand corner of the screen: 
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• Permissions for this project will pop up. You will see users with inherited 

permissions in the top list and users with granted permissions in the second list: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click the “Add” button to see a list of users. When the list of users pops up, 
highlight the user that is receiving permission, then click “Select”.  If your user 
does not appear on the lest check and see if they have been issued a BA Central 
User ID. 
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• The user will then appear on the list. Click “OK” to continue: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Highlight the new user and click “Modify” and adjust the level of access you want 
to grant the user on the list that pops up: 

 

New user….. 
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• Click “OK” to return to Projects:  
!  Make sure it says “Saved” in the bottom right-hand 
corner of the screen. If it still says “Edit”, click on it once to save current changes: 
 

 
 
 
 

Account Groups 
An Account Group is a way to organize accounts for reporting purposes.  For example, if 
you wanted to set up reports so that all accounts for one particular Principle Investigator 
are together or all NSF accounts are together.  Open the Accounting Forms menu and 
click on Account Groups 

New user….. 
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The system brings up the Account Groups screen. 

Click on the New Form  icon to create a new Account Group 

 

The system returns the Add Account Group screen. 

1. Enter the Code (up to 15 characters including spaces) by which you want 
to identify the Account Group.  

2. Enter the Description (up to 40 characters including spaces) of the 
Account Group 

 

       
1 
 
2 
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• Click the OK button and the system brings up a list of accounts 
• Highlight the account you want to add to the Account Group and hit the Select 

button (Note – the account selected below is a test account for demo purposes so 
it starts with a T instead of the normal FRS ledger number) 

 

The selected account appears on the right side of the screen under Account Number and 
is added to the Group 

 

• Right click on the green triangle and click New Group Member and select the 
next account you want to add to the Group 
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• Type in the first few digits of the account number you want to add, highlight the 
account number when it appears on the list, and hit the select button to add the 
account to the Group 

 

The selected account appears on the right side of the screen under Account Number and 
has been added to the Group 

 

• Right click on the green triangle and continue adding accounts (following the 
previous instructions) until the Account Group is complete 

How to Remove an Account from an Account Group   

Open the Accounting Forms menu and click on Account Groups 
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• Click on the filters tab 

 

• Enter the Account Group (or part of the Group Code followed by the % -- the 
search below asks for every Group code that starts with VPR) in the Group Code 
box and click apply 

 

System displays the existing the Account Groups that met the “Filter” criteria 

 

• Click on the green triangle next to the Account Group you want to edit 
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System displays the Account Group Members 

 

• Right click on the Account Number you want to remove and hit “Delete” on the 
pop up box 

 

 

 

 

System asks if you are sure 

 

 

• Click the Yes button to delete the account from the Account Group 
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System displays the revised Account Group  

 
 
 
 
 
 
 
Project Groups 
 

• Open the Accounting Forms Menu and Click on Project Groups 
 
 

 
 

The system will open the Project Groups Screen below.  
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• Click on the “Filters” tab. 
• Enter the name of the Project Group you want to use, in order to verify that the 

Project Group name is not already in use. Entering VPR% returns all Project 
Group names that start with VPR. 

• Click the Apply button.  
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The system returns all Project Group names that start with VPR. 
 

 
 
 
 
 

• Click the “General” tab if the Project Group name you want to create is not on 
the list returned by the filter on the previous page. 

 

 
 
• Click the New icon:  
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• The following screen will come up: 

 

 
 
 
 

• Add code name and description you want for this group: 

 
 

• This will add your group to Project Groups: 
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• Right click on the green triangle to add projects you want in this group 
 

 
 

• Click on New Group Member 
• Select what project the user wants to add to the Group 
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• The system will add the project to the Group 
 

 
 

• Repeat these steps for each project you would like to add to the Group 
 

 
 
How to Remove a Project from a Project Group   

Open the Accounting Forms menu and click on Project Groups 

 

• Click on the filters tab 
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• Enter the Project Group (or part of the Group Code followed by the % - the search 
below asks for every Group code that starts with Office) in the ?Group Code box 
and click apply 

 

• System displays the existing the Project Groups that met the “Filter” criteria 

 

• Click on the green triangle next to the Project Group want to edit 

 

• System displays the Project Group members 
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• Right click on the Project you want to remove and hit “Delete” on the pop up box 
 

 
 
 
• The system asks if you are sure 
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• Click the yes button to delete the project from the Project Group 
 
• System displays the revised Project Group 
 

 
 
 

 
 

Copying account information from year to year: 
 

• Click on “Forms” from the left menu under Accounting. 
 
• Locate the Accounting menu and click on the first item: “Account Information” 

 
 

• Click the “Filters” tab and enter the six-digit FRS account number for the year 
whose information you are going to copy. Then click “Apply.” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Account FRS # 
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The existing account information will appear.  
 

• Next, click on the “Copy Account” button, which is on the left side of the menu 
above the tabs: 

 
 
 
 
 
 
 
 

 
 
 
 
 
• A “Copy Account” screen will pop up. The account information will 

automatically appear. Double-check the data and make any necessary changes. 
Make sure there is a check next to “Automatically Increment by One Year” and 
then click “OK” 

 
 
 
 
 
 
 
 
 
 
 

• You have just copied the account information onto a new year. Be sure to click 
the “Set Year as Current” button to change from the previous year to the current 
year.  The account that is set as current is the one future data will be automatically 
entered into. If you have not finished last fiscal year, do not set a future year as 
current. 

 
 
 
 
 

######                           FY 
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When you pull up DIW the system automatically assumes it is the “Year set as 
Current”. 
 
 

• To save your changes, click once on “Edit” at the bottom of your screen. It will 
then say “Save” which means your information is now saved. 

 
 
 
 
 
 
 
 
 
 
 

 

Entering Transactions (Other than payroll) 
 

Awards (Budgets) are the original amount of monies budgeted to an account. 
• Go to the Accounting/Accounting Forms Menu 
• Click on “Awards” 
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The system brings up a blank “Awards” screen in  mode on the “General” tab. 

 
• Click on the “Filters” tab or hit the  Filter key in the second row from the top. 
 
The system is now on the “Filters” page. 
  

 

FRS # 
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• Filter on the “Account Number” or other information to see if any awards are in 

the system for your account.  This is a precautionary measure so the user can 
determine if anything already exists in the system before entering new data. 

• If there are no existing records in the system, it will return 
 in the lower left hand corner of the screen. 

• Click on the  tab and the system brings up a blank screen in  mode. 
 

 
 

1. Enter the unique Department Reference Number. (FRS #) some departments use 
FRS# -1 and then FRS#-2 for year 2 

2. Enter the Trx Date (Transaction Date). (Start Date) 
3. Choose the “Form Type” by clicking on the  button to the right of the “Form 

Type” field. 
(See the Transaction Form Types screen sample below.) 

 
• Highlight the “Form Type” and hit the  key to enter this form type on the 

“Awards” form. Select “AS Award Statement” for the initial award. 
 

                                            
 

Dept. Ref 
 

 
 
 

  

mm-dd-yyyy 
  
 
 
 

  

Form type 
  1 2 3 
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4.  Enter the description, e.g. Initial Budget, Supplement 1- August 2005, to 
make the document easily identifiable. 
5.  Enter the “Account Number” (the system will pre-fill the year with the 
year set as current on the Account Information screen). 
6.  Enter the “Project Code”, if projects are in use on this account. 
7.  Enter the “Sub-Code”. 
8.  Enter the “Amount” for this line. 

• Move to the next line and continue with the next budget item. 
 

The system will pre-fill the next line with the information, from the previous line, when 
you tab to the first field you want to change, e.g. tab to the next line project field and the 
system will pre-fill the account number and year; tab to the next line sub-code field and 
the system will pre-fill the account number, year, and project code.  
 
 
Users should always save the record before exiting the screen. 
 

 
Note that the “Total Awarded” amount, on the upper right side of the screen, updates as 
the user adds lines. Moving to a new line saves the previously completed line-note the 

 indicator on the bottom right hand side of the screen as you add lines. 
  

• User must enter the “Edit” mode to change any information in the form header or 
on a previously entered line. Click on the  icon (it will change 
to  mode), or select “Edit/Edit Record” from the tools menu, or hit 
“CTRL e” to edit the record. 

• The total awarded $ should match the amount on your ATS 
• Be sure to enter the sub code 9998 for F&A budget 

Initial Award, Supplement 1, or other dept. description, etc. 
  
 
 
 

  

4 

5 6 7 8 
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Amendments An amendment is a modification to the original award or budget for 
an account.  User may also use the “Awards” form, if the user wants to keep all the data 
in 1 form area. 
Notes: 

1. You can add modifications directly to the award 
2. If the user is posting the budget for DIW and: 

 The transaction code is 50 it will post to “Awards” 
 The transaction code is 30 it will post to “Amendments”  You can 

change the transaction code to 50 on the DIW and force it to post 
to “Awards” 

3. Posting from DIW is not recommended because FRS posts the entire 
contract and grant money under the sub-code 3000. 

 
How to Enter the Budget Directly into BA3 
 You can still keep all budget information in one form area by using “Awards”. 
Go to the Accounting/Accounting Forms Menu/Transactions and click on “Amendments” 

 
                                                          

 
 
The system brings up the “Amendments” screen on the “General” tab in “Edit” mode. 
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• Click on the “Filters” tab or hit the  Filter key in the second row from the top. 
“Filters” = search in BA3. 

 
• Filter on the “Account Number” or other information to see if any awards are in 

the system for your account.  This is a precautionary measure so the user may 
determine if an amendment exists in the system before entering new data. 

 
• If there are no existing records in the system, it will return 

 in the lower left hand corner of the screen. 
 
• Click on the  tab and the system brings up a blank screen in  mode.  
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1. Enter the “Reference #”.   
2. Enter the “Trx Date” (transaction date). 
3. Enter the “Form Type” or click on the  key next to the field, highlight 

the form type you want and hit the  key.  

                                                                                                 

 

4. Enter the “Description” for this form, e.g. UPAS transferring monies from 
Salaries to Travel, startup funds from the Provost for Dr. Wonderful. 

1. 2. 3. 

4. 
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• Enter the “Amendment Distribution” information; enter the account number, the 
system will pre-fill the year with the year set as current on the Account 
Information screen, enter the project (if projects are in use on this account), enter 
the sub-code, and the dollars. 

 

 

 
 
 
 
Note that the “Balance $” amount, on the upper right side of the screen, updates as the 
user adds lines. Moving to a new line saves the previously completed line-note the 

 indicator on the bottom right hand side of the screen as you add lines.  
 

• A user must enter the “Edit” mode to change any information in the form header 
or on a previously entered line. Click on the  icon (it will change 
to  mode), or select “Edit/Edit Record” from the tools menu, or hit 
“CTRL e” to edit the record. 

• In the case of a UPAS you will enter a negative number from one budget  
Sub-code and a positive number to another budget sub-code. 

 
 
 
Users should always save the record before exiting the screen. 
 
 
 
 
 
 

Encumbrances (other than payroll) monies obligated/set aside to meet 
known or anticipated expenses for the account/project. Sub-codes 300 and above 

  It is in this area of Priority that the Department must make some maintenance decisions 
on their accounts.  Decide whether you are going to still use Departmental Requisition 
numbers, maintain records by vendor names, what will be used as the Reference number, 
etc. The closer you come to using what will download from FRS the easier reconciliation 
will be. 
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• Go to the Accounting/Accounting Forms Menu/Transactions and click on 
“Encumbrances” 

 
                                                          

 

The system brings up the “Encumbrances” Screen in  mode. 

 

 

• Click on the “Filters” tab or hit the  Filter key in the second row from the top. 
“Filters” = search in BA3. 

 
• Filter on the “Account Number” or other information to see if any encumbrances 

are in the system for your account.  This is a precautionary measure so the user 
may determine if an encumbrance exists in the system before entering new data. 
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• If there are no existing records in the system, it will return 

 in the lower left hand corner of the screen. 
 
• Click on the  tab and the system brings up a blank screen in  mode. 

 
 
• If the expenditure does come up, check and be sure it is in your BA3 area.  

Sometimes one department will use the same reference number for many different 
departments.  You can reuse the reference number if it is not in your department.  
For example, Dining Services may use DBS123 for 5 different departments; 
therefore all 5 departments can use that reference number in Priority, as long as 
they are in different BA3 areas. 
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1. Enter the “Reference #”, e.g. ELF travel approval number, RM # (appears as M# 
in FRS) or other document identifier. (BA3 will use this reference # to post FRS 
transactions from DIW).  

2. Enter the “Trx Date” (transaction date).  
3. Enter the “Form Type” or click on the  key next to the field, highlight the form 

type you want and hit the  key.                                                                                                   

i.  
4. Enter the “Description” for this form, e.g. Dr. Wonderful San Diego 9/12-9/15 

ASP Conference. (This description will show on the “Open Encumbrances” and 
on the “Paid Transactions” listing (after it is paid) so make it something the PI or 
administrator will recognize. 

5. Enter the “Encumbrances Distribution” information; enter the account number, 
the system will pre-fill the year with the year set as current on the Account 
Information screen, enter the project (if projects are in use on this account), enter 
the sub-code, and the dollars. 

1. 
 
 
 

  

2 
 
 
 
 

  

3 
 
 
 
 

  

 
 
 
 
 
 
 
 
 
 
 

  

   4 
 
 
 
 

  
   5 
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The system will pre-fill the next line with the information, from the previous line, when 
you tab to the first field you want to change, e.g. tab to the next line project field and the 
system will pre-fill the account number and year; tab to the next line sub-code field and 
the system will pre-fill the account number, year, and project code.                      

 

 

Note that the “Total Enc $” amount, on the upper right side of the screen, updates as the 
user adds lines. Moving to a new line saves the previously completed line-note the 

 indicator on the bottom right hand side of the screen as you add lines.  
 
Users should always save the record before exiting the screen. 
 
 
 
IMPORTANT: 
 
When you are working on Purchasing Cards, keep in mind that if you have not assigned a 
unique reference numbering the departmental reference #  to the Visa log everything will 
post under the PCRD #(e.g. PCRD01).  Whatever you assign on the Visa Log before 
closing will download into FRS.  The reference space on the Visa log is limited to seven 
(7) digits.  Some departments are using departmental reference numbers, some 
departments are using One initial of the card owner ,mm ,yy, and the transaction number, 
for example c050803 (Coyote, May08, third transaction on the log). As long as this 
information is added to the log before closing it will post in FRS and DIW with the 
information. 
 
 
 
 
SMART ENCUMBERING: 
 Smart Encumbering can be used to average out the payments on ongoing charges 
on an account, such as monthly telephone charges. 
 
 Open your encumbrance and double click on the amount. 
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The following screen will come up: 
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Direct Expenses A Direct Expense is a form that makes an immediate affect on the 
account balance.  Direct Expenses do not have encumbrances to expend against. (This 
form is usually used to enter year to date or project to date expenses during conversion.) 

• Go to the Accounting/Accounting Forms Menu/Transactions and click on “Direct 
Expenses”. 
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The system brings up the “Direct Expenses” Screen on the “General” tab in  
mode.

 
• Click on the “Filters” tab or hit the  Filter key in the second row from the top. 

“Filters” = search in BA3. 
• Filter on the “Account Number” or other information to see if any direct expenses 

are in the system for your account.  This is a precautionary measure so the user 
may determine if a direct expense exists in the system before entering new data. 

• If there are no existing records in the system, it will return 
 in the lower left hand corner of the screen. 
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• Click on the  tab and the system brings up a blank screen in  mode.  

      

 

1. Enter a unique “Reference #. (This transaction is immediately expended on 
account reports as of the date it was entered. If you use YTD at the beginning of 
your reference number the automatic F&A will ignore these charges and you 
will need to enter the cumulative F&A) 

2. Enter the “Trx Date” ( FRS transaction date). mm-dd-yyyy. It is recommended 
you use the last month end date prior to conversion. For example, if you 
reconciled through March, 2008 then this date would be 03/31/2008 

3. Enter the “Form Type” or click on the  key next to the field, highlight the form 
type you want and hit the  key.  

4. Enter the “Description” for this form, e.g. YTD expenses for Project XYZ or 
Telephone July. (This description will show on the “Paid Transactions” listing 
for the month it is entered, so make it something the PI or administrator will 
recognize.) 

5. Enter the “Direct Expenses Distribution” information; enter the account number, 
the system will pre-fill the year with the year set as current on the Account 
Information screen, enter the project (if projects are in use on this account), enter 
the sub-code, and the dollars. 

The system will pre-fill the next line with the information, from the previous line, when 
you tab to the first field you want to change, e.g. tab to the next line project field and the 
system will pre-fill the account number and year; tab to the next line sub-code field and 
the system will pre-fill the account number, year, and project code. 

    1 
 
 
 
 
 

  

2 
 
 
 
 
 
 

  

    3 
 
 
 
 
 
 

  

    4 
 
 
 
 
 
 
 
 

  

    5 
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Note that the “Total Expended $” amount, on the upper right side of the screen, updates 
as the user adds lines. Moving to a new line saves the previously completed line-note the 

 indicator on the bottom right hand side of the screen as you add lines.  
 
 
Users should always save the record before exiting the screen.  

 

Income (for all sub-codes beginning with 0) - The Income form is used 
in the same manner as the Encumbrance form.  It is used to encumber Income monies the 
department expects, but has not yet been received, as well as real income dollars that 
have been received by the department. 
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• Go to the Accounting/Accounting Forms Menu/Transactions and click on 
“Income”.   

 
                                                          

  

The system brings up the “Income” form on the “General” tab in  mode.  
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• Click on the “Filters” tab or hit the  Filter key in the second row from the top. 
“Filters” = search in BA3. 

 
 
• Filter on the “Account Number” or other information to see if any income forms 

are in the system for your account.  This is a precautionary measure so the user 
may determine if an income form exists in the system before entering new data. 

• If there are no existing records in the system, it will return 
 in the lower left hand corner of the screen. 

• Click on the  tab and the system brings up a blank screen in  mode.  

 

1. Enter the reference number. 
2. Enter the “Trx Date” (transaction date). 
3. Leave “Projected Income” box blank, unless the user never wants to post 

against this transaction.  
4. Enter the item description. 
5. Enter the accounting distribution information. 

 

    1 
 
 
 
 
 

  

    2 
 
 
 
 
 

  

    4 
 
 
 
 
 

  

    5 
 
 
 
 
 

  

    
 
 
 
 
 

  

    
 
 
 
 
 

  

    3 
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The system shows this item as an “Open Encumbrance” on the financial 
statement (and includes it in the account balance) if the “Projected Income?” 
box is not checked.  

 

The system shows this item as “Projected Income Remaining” BELOW the account total 
on the Financial Statement Report.  

 

If “Projected Income” is checked you cannot post a deposit to this entry. 

The example below was used to generate the Financial Statement directly 
above.
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Notes/Reminders about Income: 
 

1. Remember when entering “Income” to always use a positive number for 
an income deposit 

2. BA3/DIW will show a positive number 
3. FRS will still show a negative number because it is a credit on the 

account. 
4. When posting cash deposits use this number from your deposit slip as your 

reference number (drop the 0 and pick up the number after the hyphen). 
This is what DIW will post to.  In this case the number would be 7353101. 

 

 
 
 
 

5. Remember when doing a JV to do a transfer of income that you use a 
positive number and therefore your initial account becomes the debit 
account number and the transfer to account number becomes the credit 
account number  

 
BE SURE TO SEE PERSONNEL SECTION BEFORE TRYING TO ENTER DIW 
 
 
 
Data Import Worksheet (DIW) BA3 has the ability to download 
transactions from the campus FRS system and the Statement of Payroll Charges (SOP). 
 The Data Import Worksheet lists the transactions that are available from the campus 
systems.  It works as a filter because the user decides which transactions should and 
should not be posted against the account.  
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 The SOP detail is available by person in the DIW.  
  The SOP transactions post against payroll encumbrances using the UID as the 

“Reference”.  
 Fringe Benefits (other than tuition remission) are normally encumbered and 

posted as sub-code 2700 on grant/contract accounts. If there is no 
encumbrance and the user posts a transaction with the “override” the system 
will post each fringe benefit sub-code separately. 

 The fringe benefits appear on the DIW, depending upon the account type set 
on the Accounting Forms Menu/Account Information Screen, as “Records 
Remaining to be Processed” for grant/contract accounts and “Records that 
have already Processed Successfully” for State (no benefits) Accounts. 

 SOP Corrections (payroll transfers except for pay periods 1) are imported on 
pay periods 1 only. Payroll transfers (Corrections on the SOP) for pay periods 
2-27 are duplicates of payroll transfer transactions that appear as PT batches 
in the FRS transaction listing. 

 DIW imports all items on the FRS report of transactions including payroll 
transfers, journal vouchers, vendor payments, encumbrances and all other FRS 
transactions on the DIW. 

Tip – See the Import Filter Rules in the BA3 Operating Rules document. (There will be a 
link to the most current Import Filter Rules) 
 
Go to the Accounting Forms Menu and click on the “Data Import Worksheet”  

      



 64 

 
Important – The DIW will post to the year set as current on the 
Account Information screen.  If FY 2006 is the year set as current and the user 
posts June 2005 transactions, the transactions will post to FY 2006. See page 41 
 

The system brings up the DIW. 
• Click on the “Tolerances” tab to set the user per transaction tolerance level. This 

is the dollar amount or percentage amount (over expenditure compared to the 
encumbrance) that determines whether the transaction will post or the system 
generates a warning message. Set this up once on every computer you use. 

• NOTE: If you are on a new computer the “Tolerance…” screen will automatically 
open. 

 
 

 
• Enter the user tolerance level by dollar or percentage. 

This example has the tolerance set to $1.  Any transactions that are within $1 of the 
encumbrance amount will post. 

 
 

• Click on the “Filters” tab (see 1) or select the “Account” and “TrxDate” (see 2) 
from the drop down boxes. 

2 
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The filters tab will return/show only those items for which the user has filtered, the 
Account and TrxDate will show all unposted transactions available for the account. 
 
 The screen below appears if the user clicked the filters tab. 
 

• Enter the data for the field(s) on which you want to filter, e.g. use the account 
number and month, use the transaction type and month, use the account number, 
month, and sub-code, use the Reference, month, and account number, etc. 

• Click the  button in the lower right hand corner of the screen. 
• Click the “Options” button for the choice of records, e.g. “Show Only Records 

Remaining to Be Processed”. 
 

Example filtering on the account number and transaction month for any records 
remaining to be processed. 

 

 

FRS # 
 

  

07-2005 
 

  

1 
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The screen below appears if the user entered the “Account”, “Trx Date” and hit the “GO” 
key in the upper right hand corner or filtered on the specific data points above. Note the 
scroll bar across the bottom of the screen. 

 
 

 
 
More fields come into view as the user moves the scroll bar to the right. 

 

 
 
 

DIW Field Reference Information 

Account Number - The FRS number for the transaction.  

Year – Number used to distinguish an Account Number by year, e.g. 01, 02, 03 (or 1-3, 
2-3, 3-3) for years in the grant life or 2004, 2005, 2006 for years in a state account.  Most 
FRS transactions and SOP don’t necessarily have a year tied to the transaction, the 
system automatically uses the year “set as current” to post the record. 

Project - Project Code used to signify a sub-division of monies within an account 
(account projects are set up on the Accounting Forms Menu/Account Information 
screen.) The system will pick up the project code assigned if it can match the transaction 
to an open encumbrance.  The project code must be input on the DIW if the user is 
posting the transaction as an override without any encumbrance. 

Sub-code – FRS sub-code used to signify the type of expense, budget or revenue service, 
material or other charge received or rendered.  

Trx Code - Identifies the type of transaction associated with the transaction.  

• FRS 51 maps to BA3 101 (Encumbrance Adjustment) 
• FRS 62 maps to BA3 6 (Payroll Transfer) if the FRS reference number starts 

with “PT”, otherwise map to BA3 11 (Expenditures) 

Scroll Bar 
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• FRS 65 maps to BA3 6 (Payroll Transfer)  
• FRS 55 maps to BA3 5 (Initial Payroll Encumbrances)  
• FRS 50 maps to BA3 10 (Initial Encumbrances)   
• FRS 21 maps to BA3 30 (Budget Adjustment) 
• FRS 45 maps to BA3 6 (Payroll)  
• FRS47 maps to BA3 6 (Intercampus Payroll Transfer) 
• FRS 2X (other than 21) maps to BA3 50 (Initial Budget)  
• FRS Revenue transactions (sub-codes 0101-0999) import as BA3 transaction code 

40 (income).  The transaction sign imports the opposite of the FRS transaction 
sign, in order to match how BA3 treats Income Forms, i.e. FRS revenue of $4000 
appears as -$4000 in FRS and as $4000 on the BA3 income form. 

• All other FRS codes map to BA3 11 (Expenditures). 

 

Date - The date the transaction posted against the account per the institution.  

Amount $ - The amount of the FRS/SOP transaction imported.  

Description - FRS description or comment affiliated with the record, e.g. Vendor Name 
on a Purchase Order, “Pay To” name on a Miscellaneous Payment Form for non-payroll 
transactions, First/Middle Initials and Last Name for payroll transactions (see the sample 
above), etc.    

Post? – A check mark indicates the transaction is marked to be posted against the 
account, when the post transactions key  is clicked.  The post key is the third button 
over on the second row from the top. BA3 will attempt to post all transactions on the 
screen which have a check mark in the “Post?” column when the Post key is clicked. 

 

Override? – When checked this indicates the user would like to override any problem 
BA3 found when trying to post the transaction, e.g. BA3 will create an encumbrance 
when it cannot find one to match this transaction and then post this expenditure against 
the encumbrance it created, using the information from the DIW. Payroll transactions 
must have a person record in order to post, even with an override. The system will post 
to the default project if “Force Project Accounting” is turned on for the account and no 
project is specified in the DIW. 

Reference – This reference is the same as reference 1 on the FRS transaction listing for 
non-payroll transactions and the “Reference #” field on BA3 encumbrances.  The UID is 
used for payroll transactions from the SOP. BA3 uses this reference number to match 
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against open encumbrances in the system. See the BA3 Operating Rules-DIW Posting 
Rules. 

 

 

 

Reference2 – This reference field is the same as reference 2 on the FRS transaction 
listing for non-payroll transactions. BA3 will use this number as the check date for 
payroll expenditures (from the SOP) marked for posting. See the BA3 Operating Rules – 
DIW Posting Rules for additional information. (There will be a link to the most updated 
Import Rules) 

Comment - An explanation, note or remark affiliated with the record. BA3 sometimes 
returns a comment on a transaction to make the user aware of conflicts/problems during 
the posting process, e.g. the example below is from a user trying to post a payroll charge 
to a closed encumbrance, the system responded with “Enc Closed (Exception)”. 

 

 

Details - Details on the comment returned by BA3, e.g. “Pay Expenditure Encumbrance 
is already closed”, “no header found”, “multiple encumbrance matches found”, etc. This 
explains to the user why the transaction did not post. See the example above. 

 

Tips & Common Posting Problems 

Payroll 

• DIW returns “Person not Found” in the comments section of the transaction.  The 
Person record for this transaction either does not exist or it has an incorrect 
UID#. The DIW will NOT post the transaction (even with the “Override?” box 
checked) until the person record is entered or the UID and reference field is 

Amount 
 

UID for 
Payroll 
TRX 
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corrected. 

 

 

• DIW returns “No Header Found” in the comments section and “Pay Expenditure: 
No Payroll Encumbrance Header found matching this person and Source account” 
in the details column. The system does not have an open payroll encumbrance for 
this person on this account. 

  
o The DIW will post the transaction with the “Override?” box checked or 

the user may create the payroll encumbrance and post the transaction.  If 
the user chooses to “Override?” BA3 creates a payroll encumbrance (for 
the amount of the transaction), posts the transaction, and closes the 
encumbrance.  

o The user should input a project code, before posting with an override on 
the DIW transaction, if projects are in use on this account. 

• DIW returns “Enc Closed” (Pay Exception) in the comments section of the 
transaction. The payroll encumbrance for this person has no open balance or the 
user has closed the encumbrance. 

 
o The user may check the “Override?” box on the transaction and BA3 will 

post the transaction against the closed encumbrance.  
o The user should input the project code, before posting with an override on 

the DIW transaction, if projects are in use on this account. 

Non-Payroll Transactions 

• DIW returns “Header not Found” in the comments section of the transaction and 
“Expenditure: No header found matching this reference number. (Choose override 
to create a new header.)” The system could not find an open encumbrance with 
this reference number.  

 

o The DIW will post the transaction with the “Override?” box checked or 
the user may create the encumbrance and repost the transaction.  If the 
user chooses to “Override?”, BA3 creates an encumbrance (for the 
amount of the transaction), posts the transaction, and closes the 
encumbrance.  
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o The user should input a project code, before overriding the DIW 
transaction, if projects are in use on this account. 

o See Warning notes on Purchasing Cards on Page 70. 

 

• DIW returns “A/P/O = No detail match (Exception) and “No encumbrance detail 
found for this Account/Project/Object with reference M12345. The system found 
the reference number, but something in the Account/Project/Object was different 
from the encumbrance.  

 

o The user should correct the account number, the project, and/or the 
object, on the open encumbrance in BA3, before trying to post the record 
again.   

 

 

NOTE: When posting Purchasing card transactions, each department must decide 
on a unique reference number.  If this unique number is added to the Purchasing 
card log before the closing date, it will post to FRS which imports into DIW. If you 
override the Purchasing Card transactions as they appear on the DIW they will post 
as one large transaction. See example below. 

 

 

1. This screen shows the FRS down load of Purchase Card Transactions into 
DIW if no other information has been added to the second reference on the 
visa log: 
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2. If you try to post these transactions you will receive the notification that no 
header was found: 
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3.  You are able to choose override to post these charges but they will be lumped as 
one transaction and all the payments will be applied to that one transaction: 
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4. This screen represents the encumbrance that the override created: 

 

 

 

5. The next screen shows how the payments are lumped into one transaction and that 
there are no details in the encumbrance: 
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Marking Records as Unposted or Posted– Sometimes users may delete a 
posted expenditures and need to go back and repost expenditures they have already 
posted.  The system allows users to adjust the record and to “mark” DIW transactions as 
unposted in the system.  This allows users to repost the transaction again. The user may 
also want to mark records as posted, so the record doesn’t keep showing up on the “Show 
Only Records Remaining to be Processed” list when the user is in the DIW.  

 

 

Marking a record as Unposted  

• Go to the “Accounting/Accounting Forms/Data Import Worksheet (DIW)” (see 
page? of the Data Import Worksheet instructions if you need assistance). 
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The system returns the following screen.  Scroll the screen to the right and note the 
“Processed Successfully” in the Comment field. 

 

 

• Left click on the record you want mark as unposted. The record highlights and a 
small arrow appears in the column to the left of the “Account.” 

 

 



 76 

• Right click the mouse while on the record and the system brings up the following 
pop up screen. 

 

• Click on the “Mark as Posted” menu item.  Note - The “Mark as Posted” menu 
item acts as a toggle switch, i.e. it marks the record as unposted if the record was 
already posted, and marks the record as posted if the record was unposted. 

 

 

 

• The item disappears from the list when it is marked as unposted.  

 

 

 

• Click on the filter tab and filter on the data to bring up the specific transaction(s) 
you want to repost, e.g. the following screen used the “Account”, “Trx Month”, 
and “Show Only Records Remaining to be Processed” as the filter criteria.   
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The transaction is now available to repost. Note “Marked as unposted” in the comment 
field. 

 

 

 

Notes: 

“Marked as posted/unposted does not change payments that have been paid on 
encumbrances.  The user will need to manually remove payments from the encumbrances 
if the user is changing how the payment is posted. 



 78 

Splitting the cost of an encumbrance in DIW (screen below is how the 
encumbrance looks) 

 

• A split normally occurs when you want a cost to be spit between two or more 
project codes 

• Open the DIW screen to the encumbrances for that month 
• Highlight the encumbrance and right click on the transaction that you want to 

split 
• Choose “Spit Record” 

 
 

 
 
 
 



 79 

This screen will open.  The system will automatically split the cost 50% each.  You 
can correct the amount that you want to split.  The two costs must equal the total cost 
or the system will notify you that the costs are not correct.  The user cay split the 
transaction into more lines by clicking new split button and entering the money for 
each line on the split. 
 
 

 
 
Click “OK” 
 
Post the payment and the system will split the cost in the distribution of the 
encumbrance 
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Reconciliation Wizard BA3 allows the user to reconcile the month end BA3 
balances to the campus month end FRS report. The system provides a column by column 
comparison of FRS categories and amounts to BA3 categories and amounts when the 
user inputs the FRS numbers.  
 

• Go to the Accounting Forms Menu and click on the “Reconciliation Wizard”. 
 

 
 
 
The system brings up the Reconciliation Wizard screen.  
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The user should set the tolerance level the first time they access the Reconciliation 
Wizard. The system usually brings up the Tools menu if this the users first time in the 
Reconciliation Wizard, but if not, complete the following steps. 
 
 

• Click on the “Tools” Menu  to set the tolerance level and 
specify the closeout reports the user wants the system to produce and post to 
BACentral when the account is reconciled. 

o Click on “Customize” and this will bring up the screen shot below. The 
user entered $5 as the tolerance level in this example. The system will not 
allow the user proceed to the next step in the reconciliation process if the 
variance for the preceding step is not within the tolerance. 

 

 
 

o Click on the “Closeout Reports” tab and the system brings up a list of 
available reports. The user enters a check mark in the “Run at Closing?” 
box next to the reports they want the system to run when the reconciliation 
is posted. 

 

 
 
  

o Click on the “Printing Option” box next to the selected report titles to 
define the report set up for each reconciliation report. The options chosen 
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will remain in effect for ALL accounts reconciled by this user on this 
machine, unless the user changes them in the future. 

o Click on the Print Preview button to save the Printing 
Options in the wizard. 

o Click on the  button to return to the Reconciliation Wizard 
screen. Enter/Select the Account and Month to reconcile. 

 

The system brings up the data for the account and month selected. Note the three column 
headers (in the red boxes) that appear on the screen below. 
 

A. The BA3 column is a calculated amount from transactions in the BA3. 
B. The user enters the Institution column amounts from the FRS end of the month 

account statement. 
C. The Variance amount is a system calculated amount that shows the difference 

between the BA3 amount and the Institution amount. The variance amount must 
be within the user’s tolerance amount, as defined on the preceding pages. 

 
• Enter the budget amount from FRS in the Institution column. 
• Enters the amount of any budget transactions pending (transactions that are 

reflected in BA3, but not yet reflected in FRS) in the Institution column. 
• Enter the Prior Month’s YTD expenditure number from the previous month’s 

FRS statement. BA3 will bring up the “Prior Month’s YTD” number from the last 
time the account was reconciled in BA3, or from transactions entered as Direct 
Expenses for dates prior to the current month, if this is the first reconciliation 
for this account  in BA3.  

• Enter the current month expenditures from FRS. 
• Enter the current month IDC amount from FRS. If IDC is activated on the 

Accounting/Accounting Forms/Account Information Screen, BA3 will calculate 
the amount based on the IDC table.  If IDC is not activated on the 
Accounting/Accounting Forms/Account Information Screen, the BA3 amount 
is from transactions posted/downloaded from the DIW during the month.   

• Enter revenue (if applicable) from FRS. 
• Enter Open commitments from FRS. 
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Note the blue check mark to the left of each step below. This means the users has 
completed and reconciled the amount for this step within the tolerance level for the  

 
The next step is for the user to reconcile BA3’s open commitments to FRS’ open 
commitments. 

• Click on the “Worksheet”    tab and the system brings up a list of open 
encumbrances in BA3. Users check the “OC” box 1 if the BA3 open commitment 
is reflected in FRS or the “NR” box 2 if the open commitment is not reflected in 
FRS. The system adjusts the variance totals at the top as the user checks each 
box. The user also has the choice to choose to mark all transactions as open 
commitments reflected in FRS or not reflected. 
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• Click the “General”  tab to return to the initial screen. 

 
 
 
The user is now ready to complete the reconciliation and post the selected reports to BA 
Central. 
  

• Hit the “Post”  button at the top of the screen. 
 
The system returns the following screen. 

        
 

• Click “Yes” if this account reconciliation is finished or “No” if you need to 
redo something on the reconciliation before posting it. 

 
The system returns the following screen to let the user know the reconciliation processed 
and posted. 
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• Click the “OK” button and the system returns to the “General” tab. 
• Click on the “Documents  tab to view the closing reports. The 

example below shows the Financial Statement generated by the system for this 
reconciliation. The user can click on the spreadsheet to view the report. 

 

 
 
The Reconciliation reports are now available on BA Central. 
 
 

PERSONNEL 
Persons forms: 
 

 
• Click on “Personnel” from the left menu. The Personnel Forms Menu will appear: 
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Next, go under Personnel and 
click on the first item: 
“Persons” 
 
 
 
 
 

 
 
 
 
 
 
 
• The Persons form will pop up. Remember to first check the filters to see if there is 

existing data for the person you want to enter into the system. To do this, click on 
the “Filters” tab: 

 
Never input Social Security Numbers into the system.  This is a violation of the 
campus acceptable use policy. 

 
 

 
 
 
• Click on filter tab and enter the person’s first and last name. 
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• If the person you searched for is not yet in the system it will say “No records 
found matching filter criteria” in the bottom left-hand corner of your screen: 
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• If the person you searched for is already in the system, his or her information will 
automatically appear.  PHR will download the information. 

 
 
PHR downloads once a week, on Sunday, of all approved new appointments. 
 
• If no existing data is already in the system, click on the “General” tab: 
 
If you do not want to wait for PHR to download the information, you may enter it 
yourself by the following steps (This is not the recommended way): 
 

 
 
• Fill in required fields, which are indicated by * (asterisks): 

 
1. Person ID: This is the UID from PHR or ARES (Be sure it matches PHR exactly) 

Never input Social Security Numbers into the system.  This is a violation of 
the campus acceptable use policy. 
 

2. First Name (Be sure it matches PHR exactly) 
 

3. Last Name (Be sure it matches PHR exactly) 
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4. Display Name – First Middle Last: The system will automatically fill in the 
display name after you have entered the person’s first and last names. Just double-
check to make sure that there are no spelling errors. 

 
5. Directory Name – Last, First Middle: The system will automatically fill in the 

directory name after you have filled in previous fields.  
 

 
 
 
Note: All other fields are optional. 
• To save the data you have just entered, click on “Edit” in the bottom right-hand 

corner. It will change to “Saved” which means that you have saved the new data. 
 

 
 
 
 
 
 
! Note: If a form is incomplete, meaning you have not filled in all required fields, the 
record will not save. 
 
 
 
 

1 2 3 
4 

5 
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• Next, click the “Indicators” tab: 

 
 
 
 

• The system will show which person you are working on. The name of the person 
will appear in the lower left-hand corner of the screen: 

 
• Check any item that applies to this person (Investigator, Local Accountant, 

Central Accountant, etc.). The example below shows Sarah Brooks as currently 
active,  a local accountant, and is enabled to do payroll encumbrances: 

 
 

• It is important that you be sure to mark all indicators that apply to this person for 
future transactions.  If you fail to mark a person as an investigator they will not 
appear on the drop down box to assign to an account on the account information 
form/persons tab. 
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! Remember to save the changes that you make by clicking on “Edit” in the 
bottom right-hand corner. 

 
 
 
 
Projects: 
 
• Next, click on the “Project” tab: 
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• If this person has been given permission to view accounts and projects, his or her 

information will appear on the form (see example). If not, you need to go to 
Account Information in Accounting Forms to grant permissions to this person 
(see page ?). 

 

 
Note:  Other sections on this form are not required and are generally not used by UMCP 
 
Person Groups:  A Person Group is a way to organize Person/Payroll records for 
reporting purposes.  An example of a Person Group would be to place a particular PI’s 
Graduate Students in a group of their own.   
Open the Personnel Forms menu and click on Person Groups 
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The system brings up the Person Groups screen. 

• Click on the New Form  icon to create a new Person Group 

 

 

1. Enter the Group Code (up to 16 characters including spaces) by which you want 
to identify the Person Group 

2. Enter the Group Name (up to 45 characters including spaces)  
3. Click in the available Non-Members  box and the system displays the person 

names available 

 

 

• Highlight the person you want to add to the Person Group and hit the  
button to place the person in the Group  (Note – User may choose more than 
one person by holding down the “CTRL” key and clicking on the names they 
wish to add) 

            1 
             
 
 

                                  2 
 
             
 
 



 94 

 

The selected person/persons appear on the right side of the screen under Current 
Members and are added to the Group 

 

• Continue selecting new Group Members by highlighting the Available Non-

Members name and clicking the  button until all Group Members are added 

Removing a Person from a Person Group 

Open the Personnel Forms menu and click on Person Groups 
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The system brings up the Person Groups screen. 

• Click on the “Filters” tab 

 

• Enter the Person Group code and click Apply 

 

System displays the existing Person Group with Current Members and Available 
Non-Members 

• Highlight the person you want to remove from the Current Members and click the 
button 
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System moves the selected person back to the Available Non-Members list and 
displays the Current Members of the Person Group (Note – Users must do a 
View/Refresh [click on the word View – then hit Refresh] to see the removed Group 
Member on the Available Non-Members list) 

 

 

A person can belong to more that one group. 
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Payroll Documents 
 

• Go to the Personnel Forms menu. Locate “Transactions” and click on the second 
item: “Payroll Documents”.   

 

 
 
 

• This brings up a blank new screen on the “General” tab. Click on the “Filters” tab. 
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• Input last name (or input the first few letters of the last name followed by the %; 
the % is the wild card in Priority, e.g. Ell% will bring up Ellington, Elliott, 
Ellison, etc.) and click apply. 

 

 
 
 
 

• The system returns with the payroll documents entered for this person or with 
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New Payroll Documents (the first time a payroll document is entered for a person in 
your area)  
 

1. Click on the “General Tab” 
 
2. Fill in the person name (or select from the  button to the right of the name 

field). 
 

 
3.  Fill in the effective date of the payroll doc. This is the effective date of this 

payroll doc. It is best to leave the appointment end date blank, so future 
processing can be entered on this document.  You will enter the end date on 
the distribution line as seen on the next page. 

 
 
Note - The person record must be entered before the user can input a payroll doc for 
that person. This is normally done by the PHR System download. 

 

 
 
 

4. Comments may be used for information (e.g. Dr. Wonderful’s GA) if the 
department chooses. 

 

1 

2 
3 

4 
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Click on the “distribution” tab 

 
See the distribution screen below 

1. Enter in the base period (click on the  button to see the available choices)  
(In the case of 9 in 12 you will need to make some adjustments to post FRS) 

2. Enter the annual salary (100% or the salary for your unit); the system calculates 
the Salary/Pay Period from the Annual Salary/Base Period 

3. Enter the FTE % (100% or percentage that matches the salary you entered in the 
previous step). 

4. Enter the fringe rate (see the screen cutout on the next page). 
5. Enter the payroll distribution, including the “Account Number”, “Project” (if one 

is assigned to this entry), “Sub-Code”, and the system will pre-fill the start date 
(from the date the user entered on the “General” tab) and the “End Date” 
from the end date on the Accounting/Accounting Forms Menu/Account 
Information.  The user may override the end date. 
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• Clicking the Fringe Add button on the screen above brings up the “Locate Fringe 
Codes” screen.  Choose the appropriate fringe rate. Notice the first few numbers 
are negative numbers. 

 
 
• Click on the post/repost button on the lower right corner of the screen. 
• This creates the payroll encumbrance record for the payroll doc. 

 

 
 
 
Pay Doc Tips  

a. The effective date entered on the general screen is the date that will 
pre-fill the start date on the account distribution screen.   

b. The system will pre-fill the end date with end date on the year selected 
as current “Account Information” screen, the user can over ride this 
date with the actual end date for the entry. 

c. The system will let the user create a payroll doc that exceeds the end 
date of the account.  The system will warn the user (see the screen cut 
out below), but allow them to proceed, if they say yes. 
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d. If you double click in the info box of the distribution area, the system 
will show you how the amount was calculated.  From there you can 
view the payroll encumbrance. 

 
 
 

 
 
 
 
e. This screen will pop up: 
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f. Click on “View Payroll Encumbrance Entry” and you can see your 
payroll encumbrance. 

 

 
 
 
Contractual Employees are handled differently. 
 

• Use the start and end dates on the contract as the effective date and appointment 
end date. 

• Annual salary and annual health insurance are rolled into one amount on the 
Distribution form.  This is the way it comes through SOP.  This will then 
calculate the biweekly to match FRS. 

• Contractual employees are charged FICA and therefore you need to set 8% as the 
fringe benefits, unless it is on a no fringe account. 

 
 
 
 
Fringe Benefits Changes 
 
Sometimes you need to change the fringe benefit rate on an employee.  The most 
common change comes during open enrollment when an employee makes changes in 
their coverage or the costs go up or down. 
 
There are two ways to correct this on your pay docs. 
 
 
 
 
Example 1: 
 
Open the pay document on the personnel that you need to change. 
In this example Wile E. has 18% fringe benefits.  Open enrollment has come and his new 
policy will cost 25% of his salary. 
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Warning:  It is critical that you remember to add the new rate first and post and 
then delete the old rate and post.  Otherwise, you will break the link from the pay 
doc to the pay encumbrance. 
 

 
 
First, add the new rate to your record by pushing the “Add” button and that will pull up 
the Fringe Codes screen. 
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Highlight the correct new fringe rate and hit Select. 
 

 
 
This screen will come up and then Post/Repost. 
 
 
 

 
 
The system will tell you it has modified the record. 
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At this point you have two rates in the fringe box. 
 

 
 
Now you need to remove the old fringe rate.  Highlight the old fringe rate and hit the 
“Remove” button. 
 
Warning:  Remember to add the new rate first and post and then delete the old rate 
and post.  Otherwise, you will break the link from the pay doc to the pay 
encumbrance. 
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Hit the “yes” button. 
 

 
 
Now post again to remove the old rate on your payroll encumbrance. 
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You have successfully corrected the fringe rate on this account. 
 
This fringe benefit change will effect the entire time period of this pay doc. 
 
 
 
Example 2: 
 
You can just add the extra rate to equal the new rate. 
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The difference between 18% and 25% is 7%.  If you add 7% to this document it will 
calculate 25%. 
Hit the “Add” button and highlight the extra percentage you want and “select” 
 

 
 
Now you have two rates in the fringe box. 
 

 
 
Hit the “Post/Repost” button 
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Your record has been modified. 
 
 

 
 
The fringe benefit will now calculate at 25%. 
 
 
 

Payroll Encumbrances 
• Go to the Personnel Forms Menu 
• Click on Payroll Encumbrances 

 

 
 
• Click on the “Filters” tab 
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• Filter on the person’s last name or other user chosen field. 
 
Note the   box next to the date field.  This allows the user to set the encumbrance 
filter date greater than or equal to, equal to, or less than a specified date. The example 
below is set to greater than or equal to 07/01/05. 
 

 
Never input Social Security Numbers into the system.  This is a violation of the 
campus acceptable use policy. 
 

• Highlight the name you want on the list and hit the “Select” button. 
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The system brings up any payroll encumbrances that fit the filter criteria (the person and 
date selected in this example) on the “Filter” screen. 

 
 

Note the salary and fringe benefit encumbrances.  This is because account y32345 
is set up as a grant account (Accounting/Accounting Forms Menu) on the Account 
Information Screen and a fringe benefit rate was input on the payroll doc. 
 
 
 
 

 
 
Entering Payroll Encumbrances without a payroll doc (This is not typically 
recommended) 
 
You might consider doing this if: 
 
• You had someone being paid an award or payment that will come through payroll, 

but it is not part of their salary. 
• Users may only enter accounts they own. 
• You are doing a payroll transfer and you only own one of the account numbers.  

You cannot do a retroactive action unless you own both account numbers. 
• You have an hourly student and you want to encumber their salary for a particular 

project. 
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Go to the Personnel/Personnel Forms Menu and Click on Payroll Encumbrances 
 

 
 

• Hit the   key (the second button over in the second row) 
                           

 
• The system brings up a blank form. 

 
See the screen shot on the next page for the referenced fields. 

1. Complete the “Reference #” (user defined) 
2. Complete the “Trx Date” (transaction date) 

3. Complete the “Form Type” (note the  next to the Form Type – this brings up 
a list of available choices whenever you see it next to a field). 

4. Complete the “Person Name” (or click on the  to select/create a person) 
5. Complete the “Source Account”. (SA and account distribution MUST be the 

same) 
6. Complete the “Description” (User defined description to tell you what the 

encumbrance is when you see it on reports.) 
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7. Complete the “Salary Distribution” (the system will not let the user input an 
“Effective Date”, since that date is filled in from a payroll doc.) 

 

 
 
 
Updating a Payroll Doc  
 

• Filter on the person’s last name. 
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• Select the list from the list of names the system. 

 
 

• Click Apply (user is still on the “Filters” tab at this point.) 
 

• Click on the “General” tab. 

 
 
• The system brings up any existing payroll docs for this person. 
• Use the  buttons (second row from the top of the screen) to move 

through the existing payroll docs to the most current doc for this person (for this 
assignment, if multiple assignments are used) 

• Make sure the Appointment End Date is blank 
•  The system has three options to choose from when doing a payroll doc change. 

 
 

• Click on “Revise Current” to change the accounting distribution, the annual 
salary, etc. for an existing record.  This brings up a “Revise Current Payroll 
Form” which will create a new payroll doc and adjust the existing encumbrance 
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created by the original payroll doc. See the screen cut out at the top of the next 
page. 

• Click on “New Assignment” to enter a second assignment for the person, such as 
an overload, a TA with an hourly overload, or a second different appointment in 
the same unit. 

• Click on “Retroactive Change to calculate a payroll transfer (and set up a new 
future payroll document if required). The original payroll document must be in 
BA3 for the system to do the transfer. Transfers that affect periods before BA3 
was in use must be input manually. Both debit and credit accounts must be in your 
unit to do a retroactive transfer. 

 
 
Entering a “Revise Current” Document (Reminder – filter on the person 
first, as shown on the preceding page). 

• Click on the “General” Tab (see the preceding page if you need a reminder). 
• Click on “Revise Current” and this mini screen appears. 

 
• Fill in the “New Effective Date”. 
• Check/uncheck the “Copy Existing Notes” box. 
• Click OK and the system creates the New Payroll Doc (see the next screen shot 

for an example.) 
 

 
 
 

• Click on the distribution tab and this will bring up the distribution screen on the 
payroll document you are revising. 
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• Make any changes and click the Post/Repost button on the lower right of the 
screen. 

 

 

• Save the record, if it hasn’t saved already (click on the  button at the 
bottom right hand side of the screen or hit “CTRL S”.) 

 
Filter for and Post the original pay doc (which now has an appointment end date on 
the General Tab) so that the system will update the original encumbrance. 
 
The system will update the encumbrance from the original payroll doc and create a new 
encumbrance from the revised payroll doc. 
 
 
 
Entering a “New Assignment” Document (Reminder – filter on the person 
first as shown on page 6.) Two PHR appointments with different pay rates within the 
same Department. 
 

• Click on the “General” Tab.  
• Click on the “New Assignment” button on the lower right section of the screen. 
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• The “New Assignment” screen appears. 
 

 
 

• Fill out the “New Effective Date”.  
• Check/Uncheck the “Copy Existing Notes” box. 
• Click “OK”  

 
The system creates a new payroll document with the “Effective Date” entered above (see 
the example on the next page.) 
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• Click on the distribution tab. 
 
 

 
 
 
 
The system brings up a new distribution screen with the same data as the payroll doc the 
user was on when they hit “New Assignment”. 
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Fill in the new payroll doc with the information for the “New Assignment” 

 
 

• Click the  button on the bottom right hand side of the screen to post 
the record. 

• Save the record (click the  button if it hasn’t changed to the  
button, or hit “CTRL S” to save the record. 

 
The system will create a new encumbrance from the revised payroll doc.  The system 
does not update the original pay doc because this is a new assignment running 
concurrently with the original assignment. 
 
 

Entering “Retroactive Change” – Payroll Transfers 
 
 
To help users with the various payroll transfers refer to Addendum A in 
the back of this manual. 
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BA Central Guide 
 

Some Important General Information about BA Central 
 
• Users with BA3 access automatically have access to BA Central 
• Users without BA3 access must complete an SOU to establish a BA Central user ID and get 

access 
• Departmental BA3 Data Admins control the account and project permissions that allow a BA 

Central User to view accounting reports and projects; account permissions automatically 
confer project permissions for that account 

• The front page of My Account and My Project Watch balance date are updated every night.  
The drill down data is updated every time a user updates a transaction.  

• All BA Central Access to access the server requires use of a campus VPN (Virtual Privacy 
Network) ** 

 
**UMD user with directory ID can download a free copy of the VPN from www.helpdesk.umd.edu, search 
on VPN and follow the instructions on the screen.  Contact OIT help desk if you have trouble downloading 
or accessing the VPN 
 
Logging on to BA Central (Users with “BA Central Only” access must 
use the first option – open a web browser and enter the 
baws1.umd.edu/dashboard link) 
Connect to the VPN 
 
There are two options for a BA3 user to access BA Central: 

• Open a web browser and enter “baws1.umd.edu/dashboard” in the address line 
• Enter user id and password, then click “Log In” 

 

 
 
 

- OR – 
 

User ID Password 
 

http://www.helpdesk.umd.edu/�
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The System displays the BA Central User’s Homepage 
 
 
 

 
 
 
 
 
 
 
Setting the BA Central User Layout  
 

• Click on Layout 
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• Click the check box next to the items you want to display on your BA Central Homepage, 

(unclick the check box to remove an item from the Homepage)  
 
• Re-Order the display by Clicking on the item you want to reposition on the Homepage, 

(item changes to bold  ); then click “Move Up” or  “Move 
Down” to change the order in which the item  appears on the Homepage 

 
 
• Click the “Save Settings and Close” button to save your changes   
 

 
 

1 

2 

1 

2 
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Impersonation – A departmental Data Admin may be set up to “Impersonate” 
another BA Central User. (Units should contact Sharon Elliott (selliott at 
umresearch.umd.edu) and let her know which Data Admins need to “Impersonate” other 
departmental users) 

• Log onto BA Central with your normal user id and password 
 

 
 
System displays the Data Admin BA Central Homepage 
 

• Click on “Change User”  
 
 
 

  
 
System displays the users you may impersonate 
 
 

 
 
 
 
 

User ID Password 
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• Click on the “Directory Name” of the user you want to Impersonate 
 
 
System displays the impersonated BA Central user Homepage 
 

 
 
Data Admin may now set the layout and view any information available on the 
Impersonated User’s  
Homepage 
 
How to stop impersonating and return to the user’s BA Central Homepage 
 

• Click on “Change User” 
 

 
 
 
 
System displays the “Change User” page 
 

• Click on “Stop Impersonating” 
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System displays the User’s actual Homepage 
 
 
 

 
 
 
 
 
 
 
 
Adding an Account email Notification to a BA Central User 
 
Log on to BA Central using an Internet Browser (Do not access BA Central from 
within BA3 to add a notification, the system cannot add a notification from within BA3 
at present) 
 

• Open a web browser and enter “baws1.umd.edu/dashboard” in the address line 
• Enter user id and password, then click “Log In” 
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Impersonate the User you want to notify, by clicking on “Change User” 
 
     
 
 

  
 
System displays the users you may impersonate 
 
 

 
 

• Click on the “Directory Name” of the user you want to Impersonate 

Click on “Change User” 

User ID  Password 
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System displays the Impersonated User’s Homepage 
 

 
 
 

• Click on the account number to which you want to add a notification (the account 
chosen below is a test account so the number starts with a “t” instead of the normal FRS 
ledger number.) 

                                                                                    

 
System displays the Account View for the selected account 
 

• Click on the “Add Notification”  button 
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System displays the “Account Notifications” screen 
 

• Highlight “BA3 Account Reconciliation Notification” 
• Click the “Add Record” button 
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System displays the Account View screen with the added notification 
 

 
 
 
 
To remove the email notification:  click on the name and select delete.  
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BA Central Web Part Settings 
 
BA Central “My” Web Parts (My Accounts, My Accounts Watch, My Project 
Balances, etc.) display these  symbols on the right side of the 
information panel next to the item title. 
 

 Help button – contains basic information about the web part 
 Refresh button – refreshes the view of that particular web part, e.g. if the user hits 

the button next My Project Balances the system will refresh the project balances 
 Remember Project Balances update every night 
 Configure button – brings up the menu below and allows the user to customize all 

“My….” settings  
 Remember My Web Parts Access acts as a Filter 

 
 

• Click the  button to save the selected settings and the  button to return to the 
BA Central Homepage. 

• The user may still see other data (to which they have permission) by searching on it 
 
 

Checking any of the Account Related boxes limits the BA 
Central Homepage display to those accounts that fit the 
criteria on any of the “My…” settings with Account in the 
title, e.g. My Accounts, My Accounts Watch, etc.  
Principal Investigator, Local Accountant, and Central 
Accountant are defined on the Account Information 
Screen/Person tab in BA3. 
 
 

Setting the Account Filter limits the BA Central Homepage 
display, shown on any of the “My…” settings with the word 
Account in the title, to those accounts that fit the criteria.   

Setting the Project Related filter limits the BA Central 
Homepage display to those projects where the User is 
the defined as the Project Investigator on the Accountant 
Information /Projects Tab in BA3. 

Limits the Accounts & Projects displayed to those that fit 
the selected criteria. This sample is set to org unit VPRGS. 

Other Related allows the user to set limits based on the 
criteria chosen in any of the drop down boxes. 
 
Maximum Records to Return allows the user to choose the 
number of accounts, projects, etc. displayed before the word 
“more” appears on the BA Central Homepage. 
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Addendum A 

Payroll Examples 
To help users with payroll transfers 2 settings have been set.  Please read through them to 
help you decide which example will best fit your needs. 
 
Setting I 
 
Example 1 – Graduate Student Daisy Duck has a 12 month appointment and has an 
existing pay doc with 100% of her salary on account TT526555 (grant account) obligated 
from 10/01/2007 through 06/30/2008.  The pay doc was completed using a Leap Year Bi-
weekly. 
 
Example 2 – Ms. Duck’s PI initiates a change in her salary distribution account to 100% 
on account T12345 (probably after prompting from the Business Office Staff) starting 
January 1, 2008 through June 30, 2008.  Ms. Duck’s PI initiated this change in enough 
time for PHR to be updated and the salary to flow through FRS on the correct accounts.  
 
 
Example 3 – Ms. Duck’s PI reviewed his January 2008 account statements and directed 
that her salary for the period 12/01/2007 – 12/31/2007 be transferred to accounts t22345 
(50%) and  111TTT (50%). This change was made after the fact (the payroll had already 
processed in PHR and been charged to the original account) and required a payroll 
transfer. 
 
 
Example 1 – Initial Pay Doc for Daisy Duck (General Tab) 
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(Example 1 - Distribution Tab) 
 
 

 
 
 
 
 
Initial Payroll Encumbrance form created by the Example 1 Pay Doc 

 
 



 134 

Example 2 – Revise Current Pay Doc modifying Example 1  Pay Doc (General Tab) Note 
the New Effective Date 
 

 
 
 
 
 
 
Example 2 - Distribution Tab after the account change was made. 
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Example 2 New Payroll Encumbrance form after posting the “Active Pay Doc: Starting 
01-01-2008”. 
 

 
 
 
 
 
Example 2 - Screen image of the original Example 1 Pay Doc after the new Revise 
Current Pay Doc was created.   Note the Appointment End date. 

 
 
**Post the Original Example 1 Pay Doc with the Appt End of 12-31-2007 
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Example 2  - Payroll Encumbrance for the Example 1 Doc after posting the Appointment 
End change made by the Example 2 “Revise Current” process.  Note the difference in the 
encumbrance amount on this account. Compare it with the encumbrance amounts on this 
account from page. 
 

 
 
 
Example 3 – Retroactive Change [Payroll Transfer] starting with the Example 2 Pay Doc 
General Tab after Example 2 was completed.  
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Example 3 – Preceding Example 2 Doc after clicking the Retroactive Change button 

 
 
 
Retroactive Payroll Change Wizard after clicking the Next button 
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Example 3 - Retroactive Change Wizard with screen 2 completed. This example is 
moving the payroll from 12/1-12/31/07 to other accounts. Note that the Create a new 
Current Assignment Pay Doc box is unchecked. 

 
 
 
 
Screen after clicking the Next button. 

 
 
 



 139 

Example 3 - Screen after clicking the No button on the preceding screen. (The No means 
that it is okay for the start date of the change not to be a pay period start date.) 

 
 
 
Screen after clicking the No button. (The No means that it is okay for the end date of the 
change not to be a pay period end date.) 
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Example 3 - Screen after clicking the Next button on the preceding screen. (This screen 
allows for a retroactive salary & pay schedule adjustment.) 

 
 
 
 
Screen after clicking the Next button 
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Example 3 - Make the changes on the New Payroll Distribution line(s) and modify the 
end date(s), if necessary. (The system will use the End Date on the Account Information 
screen unless the User inputs another date.) User may input the % or the Period $. 
 
 
 

 
 
 
 
 
 
 
 
 
Screen Shot after clicking the Next Button (check the bi-weekly distribution – sometimes 
these are a penny or two off; adjust the bi-weekly distribution by amount instead of %, if 
necessary) 
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Example 3 - Screen shot after clicking Yes. 

 

                            

                                   
 
Example 3 - Screen shot after clicking the Finish button. 
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Screen returns to the pay doc after clicking the Yes button.  The retroactive change doc 
has not been posted yet.  Filter on Daisy Duck and review the pay doc that was 
created. 
 
Retroactive Pay Doc that was created. (General Tab) Note the comments. 

 
 
Example 3 - Retroactive Pay Doc (Distribution Tab) from the new Pay Doc created on 
the preceding page. 
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Post the Retroactive Document and watch for the number of record modifications. 
Payroll Encumbrance screens after posting the Retroactive Document. Note the three 
accounts involved. 
Retro Pay Doc Encumbrance on Account 
t22345

 
 
Example 3 Retro Pay Doc Encumbrance on Account TT526555 
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Retro Pay Doc Encumbrance on Account 111TTT 

 
 
Example 3 Click on the Payroll doc Summary tab and view the funding summary.  
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Setting II 
 
Example 4 – PI Grand Mere has a 12 month appointment and an existing pay doc that 
started on 08/21/2005 with 100% of her salary on account T24654. Grand Mere received 
a raise on 07/01/2006 and changed her account distribution to 75% on 111TTT (year 
2007), 10% on account t22345, and 15% on account T12345. The original pay doc was 
completed using a b (12 month bi-weekly) pay schedule. Business Office Staff completes 
the pay doc using account distribution end dates of 06/30/2007 for all accounts.  
 
Example 5 – PI Grand Mere reviews her August account statements and says there will 
be another account coming in and she’ll move her % on account t22345 to that account in 
October. The new account number is unknown at this point. The encumbrance on 
Account t22345 should only go through September.  The Business Office Staff changes 
the end date (for that one account distribution) on the existing Pay Doc and reposts it. 
 
Example 6 – PI Grand Mere receives new account number GM56789 on 10/01/2007, 
with a 09/15/06 effective start date.  She elects to change her salary distribution as of 
09/15/06.  The change has missed the PHR deadline and will require a payroll transfer. 
The change was effective in PHR on 10/01/06.  
 
 
Example 4 – Initial Pay Doc for Grand Mere (General Tab) 
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Example 4 – (Distribution Tab) 

 
 
 
Example 4 - Initial Encumbrance Screen for the preceding Pay Doc. 
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Revise Current Pay Doc modifying Example 4 (General Tab.) Note the New Effective 
Date 

 
 
Example 4 - New Pay Doc Distribution Tab created by the Revise Current process. Note 
that the distribution is the same as the original Pay Doc until it is modified. 
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Example 4 - Revise Current Pay Doc after the Annual Salary and Account Distribution 
were modified. 

 
 
 
Example 4 – Revise Current Pay Doc after Posting. Note that 3 records (corresponding 
to the number of distribution records) were modified. 
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Example 4 – Payroll Encumbrances created by posting the Revise Current Doc Note that 
there are three Encumbrance Forms created by this posting this pay doc. 
 
Example 4 - Account t22345 

 
 
 
Example 4 - Account T12345 
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Example 4 - Account 111TTT (Year 2007)               

 
 
 
Example 5 – Existing Pay Doc for Grand Mere (General Tab.) 
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Example 5 – Initial Distribution Tab for the preceding Pay Doc. 

 
 
 
Example 5 – (Distribution Tab) Distribution End Date changed to 09/30/2006 on account 
t22345. 
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Example 5 – (Distribution Tab) Pay Doc after clicking the Post button. 

 
 
 
Example 5 – Encumbrance Screens after the preceding Pay Doc was posted. Note the 
change in amount on account t22345. Compare it to the original encumbrance on page 
18. The encumbrance amount for the other two accounts remains the same. 
 
Example 5 - Account t22345 
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Example 5 - Account T12345  

 
 
 
Example 5 - Account 111TTT (Year 2007)  
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Example 5 – Payroll Document (Summary Tab) after changing the distribution end date 
on account t22345 to 09/30/2006. Note the line (red on the screen) that indicates only 
90% of Grand Mere’s salary is covered as of 10/06. 
 

 
 
 
Example 6 - Current Active Pay Doc for Grand Mere after Example 5 was completed 
(General Tab.) 
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Example 6 - (Distribution Tab) 

 
 
 
 
Example 6 Pay Doc Screen after clicking the Retroactive Change button (General Tab) 
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Retroactive Payroll Change Wizard after clicking the Next button 

 
 
 
 
Example 6 - Retroactive Payroll Change Wizard with the Person Information screen 
completed.   Note that the Create a new Current Assignment Pay Doc that reflects these 
Retro Changes box is checked. This creates a future payroll doc with the same changes 
as the retroactive change. 
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Screen after clicking the Next button 

 
 
Click the No button (the No means that is okay for the start date of the change not to be a 
pay period start date.) 
 
Example 6 - Screen after clicking the No button from the preceding screen. 

 
 
 

System screen bug – BA3 will create a 
new Assignment 1 Doc for this 
example, because the Create a new 
Current Assignment Pay Doc box was 
checked, but this screen omits it. 
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Click the Next button and the following screen appears. If no changes are required (on 
this screen) click the Next button. 

 
Example 6 - The screen below appears after clicking the Next button on the preceding 
screen. 

 
 
Example 6 - Make the changes on the New Payroll Distribution section of the screen and 
click the Next button.  Note the End Date section of the screen. The system will use the 
End Date on the Account Information screen (for this account) unless the user enters a 
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different End Date. End Date 06/30/2007 was input for account GM56789 in this 
example. 

 
Example 6 – The screen below appears after clicking the Next button on the preceding 
screen. 
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The screen below appears after clicking the Next button on the preceding screen. 

                
 
 
 
  Example 6 – The screen below appears after clicking the Finish button on the preceding 
screen. 
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Click Yes and the system creates two new payroll documents.  Documents 1 & 2 that 
follow were created by the Retro Wizard. 
 
 
 
 
 
1) Retroactive Adjustment Assign 2 Pay Doc created by the Retro Wizard (General Tab) 
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Example 6 - (Distribution Tab for the preceding Pay Doc) 

 
 
2)  New future Assign ID 1 Payroll Document with the same account distribution as the 
retroactive change (General Tab.) 
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Example 6 - (Distribution Tab) Note the end dates on the distribution tab. These are from 
the End Date on the Account Information screen. Edit the End Date fields to the date the 
user wants to end the encumbrance (06/30/2007 in our sample.) 

 
 
(Distribution Tab) The same Pay Doc after the End Date field was made 06/30/2007 for 
all accounts. 
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Example 6 - Post all three Pay Docs (the New Effective Document reflecting Retro 
Changes, the Retroactive Payroll Adjustment, and the original Pay Doc that now has an 
end date.) 
 
 New Effective Document 

 
 
 
Retroactive Payroll Adjustment Document 
 

 
 
 
Original Pay Doc with the Appointment End Date completed. 
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Example 6 - Pay Doc Summary Tab on the New Effective Document after the preceding 
three docs were posted. 
 

 
 
Payroll Encumbrances after Example 6 Pay Docs were posted. 
 
 
 
 
 
 
Account t22345 
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Account T12345 

 
 
Account 111TTT 
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Account GM56789 

 
 
 
 
***The payroll transfer should be posted on the 09/15/06 line and the normal 
payroll should be posted on the 10/01/06 line. The users should receive a “Multiple 
Encumbrance Match” warning when posting from the DIW. Double click on the 
DIW Reference number and the system will bring up both encumbrance lines. The 
user should highlight the line to which they want to post the DIW transaction and 
hit the Post button on the pop-up screen. 
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